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Lag et nytt EndNote-bibliotek

Nar du apner EndNote Desktop for fgrste gang, far du en gra skjerm med en menylinje pa toppen.
For a ta programmet i bruk, trenger du et bibliotek, som kan opprettes ved a klikke pa File > New. Gi

biblioteket et navn og klikk Save. Det nye biblioteket dpnes automatisk.

=  For a apne et eksisterende bibliotek, ga til File > Open Library... og finn frem biblioteket ditt.
= Et EndNote-bibliotek bestar alltid av en EndNote-fil med bibliotekets navn (f.eks. Endnote) og en
mappe med samme navn (Endnote.Data). De to delene ma alltid lagres sammen for at biblioteket

skal fungere problemfritt.

=  For a lagre en sikkerhetskopi av biblioteket i en komprimert fil: G til File > Compressed Library

(.enlx), og velg hva som skal veere med i biblioteket.
Klikk pa OK for a lagre filen pa gnsket sted.

Layout

Apner du et nytt bibliotek, vil skjiermbildet se slik ut:

[ EndNote 20 - Nytt bib.enl
) Sync Configuration [Q ] [ Advanced Search J
[l All References All Ref
eferences -
£ Recently Added @

0 References

B unfiled

T Trash

Recor | @ | Forfatter ~| Ar

| Tittel

v MY GROUPS
v My Groups
“ FIND FULL TEXT
“ GROUPS SHARED BY OTH...

v ONLINE SEARCH
@ CrossRef
@ Library of Congress 1
@ LISTA (EBSCO)
@ PubMed (NLM)
@ Web of Science Core C...

more...

e x

No Reference Selected

Referanseoversikt
Gruppepanel: Viser gruppene som biblioteket er inndelt i
Referansepanel: Visningsfelt for markert referanse

e wnN e

Databaser for sgk pa nett

Kolonneoversikt for referanselisten. Hgyreklikk eller ctrl-klikk for a velge kolonner som vises



Eksempel pa bibliotek:

[ ] EndNote 20 - My EndNote Library-Converted.enl

l { Advanced Search J Ii Utdann...015 #12

All References o D
2 Dokument1 a @ Attach file

&\ Imported References 24 References
Ja¥ Recently Added
B Unfiled

@ Trash

X

= Sync Configuration =

Leereplan i kroppseving

Recor | @ |Forfatter ~| Ar | Tittel
Utdanningsdirektoratet
3 Monsen, Lars 2002 Nadeles villmark : 2015 Report Number: KRO1-04
v MY GROUPS
25 Myhr, Eirik; Reuterstrand, Siri 2002 Vilt og fisk : jegerd DOI:

v My Groups http://data.udir.no/kIO6/KRO1-04.pdf
(@ kosthold 29 Myhr, Eirik; Reuterstrand, Siri 2002 Vilt og fisk : jegerg

@ Oppgave
22 QOvayolu, A,; Arslanbuga, C. Y.; Gun, I.; Dev... 2016  Can blood and se
v FIND FULL TEXT

« GROUPS SHARED BY OTH... 28 Pears, Richard 2010  Cite them right : tl

“ ONLINE SEARCH Taylor, H. 1991 Invitro fertilisation|
@ CrossRef
@ Library of Congress
@ LISTA (EBSCO)
@ PubMed (NLM)
@ Web of Science Core C... 23 Yasin, A. L.; Yasin, A. L.; Basha, W. S. 2016  The Epidemiology|

more...

Utdanningsdirektoratet Leereplan i kropps

Weinstein, Louis

Syndrome of hem

APA 7th 2] copy Citation ] v

Utdanningsdirektoratet. (2015). Laereplan i
kroppseving (KRO1-04). http://data.udir.no/

26 Aadland, Erling 2000 Fortelleren og skr KI0B/KRO1-04.pdf

27 Adland, @yvind 2006 Problemet med dg

Legg nye referanser til biblioteket

Det finnes flere mater a samle referanser i EndNote. Man kan eksportere referanser fra fagdatabaser
ved a laste ned en referansefil, spke i databaser via EndNote, eller legge inn referanser manuelt.

Eksporter referanser fra en database

For a eksportere referanser fra en fagdatabase, fglger du som regel disse stegene:
1) Sgk etter et emne i en relevant database
2) Kryss av for en eller flere aktuelle artikler i trefflisten
3) Klikk pa en knapp eller lenke med navnet cite, send to, download eller export.
4) Last ned referansene i EndNote- eller RIS-format.
5) Klikk pa filen i nedlastinger eller dra den til EndNote-ikonet for a importere
Ting kan ga galt under import av referansene. Opplysninger kan havne feil i felt, og de kan ogsa veaere
registrert feil. Du bgr derfor alltid korrekturlese referansene du har lastet inn.
Nedenfor finner du to eksempler for referanseeksport til EndNote fra Oria og Google Scholar.
Se hvordan du eksporterer referanser fra andre databaser pa bibliotekets EndNote hjelpesidene
(«Eksport av referanser fra databaser til EndNote Desktop»).
Eksport fra Oria:
1) Sek opp referansen du vil overfgre
2) Klikk pa sitattegnet: **
3) Klikk pa EndNote



BOK L
Vilt og fisk : jegerens og fiskerens kokebok
2002

Tilgjengelig fra Hogskulen pa Vestlandet

” = = & (2] (2] 5B 2]

SITER E-POST SKRIVUT PERMALENKE RIS BIBTEX ENDNOTE ENDNOTE
ONLINE

Tegnsett (velg UTF-8) ¥

LAST NED

Klikk OK i vinduet som apner seg (du trenger ikke a forandre innstillingene)

Lagre filen og/eller dpne den med EndNote

Korrekturles den overfgrte referansen

For a redigere referansen, markerer du den i biblioteket og klikker Edit gverst i
referansepanelet. Klikk deg inn i feltet som skal redigeres. Klikk pa File = Save (cmd+S) for a
lagre endringene.

= My, 2002 #29 X

B I U X' X Q
Aumor Myhr, Eirik
Reuterstrand, Siri

Year ogp2

Title  vilt og fisk : jegerens og
fiskerens kokebok

Series Editor

Series Title it & fiskkokboken

Place Published (gjq

Publisher Gyldendal
Volume
Number of Volumes
Series Volume
Number of Pages
Pages
Editor

Edition

Neao

| eksempelbildet over star en referanse eksportert fra Oria til EndNote, med
utgaveinformasjonen pa norsk (utg.). | EndNote legger referansestilene automatisk til utg. pa
norsk eller ed. pa engelsk, og dette skal derfor ikke veere med som referansedata. | feltet
Edition skal det bare sta selve tallet. Feltet Series Title skal vaere tomt.

£ X



Eksport fra Google Scholar:
1) Sek opp referansen du gnsker a overfgre
2) Klikk pa sitattegnet

rroF] Ressurser av torsk og andre fisk i fiorder pa den norske Skagerrakkysten
J Gjosaster, K Enersen, SE Enersen - 1996 - brage bibsys.no

The abundance, distribution and life history parameters of cod, Gadus morhua L., and other

fish species were studied at the Norwegian Skagerrak Coast. 12 surveys were conductad in

the Sandeledfjord and the Sandnesfjord in the Riser area during the period March 1993 til1 .

ko Sitert av 18 Beslektede artikler Find it @ HVL HTML-versjon <4
3) Idet nye vinduet, klikk pa EndNote

X Referanse

MLA  Gjesaster, Jakob, Kate Enersen, and Svein Erik Enersen.
"Ressurser av torsk og andre fisk i fjorder pa den norske i
Skagerrakkysten.” (1996). I

APA - Gjesaster, J., Enersen, K., & Enersen, 5. E. (1996). Ressurser
av torsk og andre fisk i fjorder pa den norske Skagerrakkysten.

S0 690 GJISETER, Jakob; ENERSEN, Kate; ENERSEN, Svein Erik.
Ressurser av torsk og andre fisk i fjorder pa den norske
Skagerrakkysten. 1996.

BibTeX Reflan RefWWorks

4) Lagre filen og/eller dpne den i EndNote
5) Korrekturles den overfgrte referansen

Sek i fagdatabaser via EndNote

| Online Search kan du sgke etter referanser direkte i EndNote, uten at du ma apne databasen i
nettleseren. En del spkefunksjoner fra fagdatabasen vil mangle, sa Online Search anbefales bare for a
spke opp helt bestemte referanser, ikke for stgrre litteratursgk.

1) Velg database fra Online Search i panelet til venstre
Klikk pa more... om du ikke ser gnsket database i listen
2) Fyll ut ett eller flere sgkefelt, kombiner dem med And eller Or, og klikk pa Search
3) Kopier referansene til biblioteket ved a markere dem i trefflisten og klikke
= NB: Mange databaser krever palogging, og vil veere utilgjengelige for bruk, men du kan forsgke a
logge inn uten brukernavn og passord.

Legg inn referanser manuelt

Referanser for bgker og tidsskriftsartikler kan du stort sett eksportere fra Oria eller fagdatabaser til
EndNote. For en del andre kilder er det ngdvendig a legge inn referansen manuelt, f.eks. nettsider,
avisartikler, lover og forskrifter, rapporter, retningslinjer eller bilde- og lydmateriale.

1) Ga til References > New Reference (cmd+N) eller klikk pa ﬁ
2) Velg passende Reference Type og fyll ut de ngdvendige feltene
3) Lagre referansen ved a klikke Save (cmd+S)
4) Lukk referansen. Referansen finner du igjen under All References



For a finne passende Reference Type for kilden du bruker og for a sjekke hvilke felt som ma fylles ut,
kan du se pa eksempelsamlingene pa bibliotekets EndNote-hjelpesider, Sgk og skriv eller

Kildekompasset.
=  Feltet Author fylles vanligvis fylles ut i formen:

Etternavn, Fornavn

Men EndNote vil ogsa forsta Fornavn Etternavn. Organisasjonsnavn som bestar av flere enn ett
ord ma derfor fgres inn med komma etter, for 3 unnga at navnet inverteres som et personnavn:
Hggskulen pa Vestlandet,

Nar det er flere forfattere, skilles de med linjeskift.

Forhandsvisning av referanser

Nar du har lagt nye referanser til biblioteket, kan du sjekke om de faktisk kan formateres til
komplette og korrekte referanser i henhold til en referansestil. Forhandsvisningen finnes i nedre
hgyre hjgrnet, under Summary-feltet. | utgangspunktet kan forhandsvisningen veere skjult, og kan
vises ved a klikke ~ #~

APA 7th ¢] [ copy Citation | W

Bryman, A. (2006). Integrating quantitative and
qualitative research: how is it done?
Qualitative research, 6(1), 97-113.

Her vises referansen i APA 7th. Andre stiler er tilgjengelig under denne menyen.

EndNote og Word

Nar EndNote er installert, vil du finne en verktgylinje i Word med navn «EndNote 20». Denne bruker
du til 3 sette inn referanser fra biblioteket ditt, velge gnsket referansestil og til a tilpasse
referansehenvisningene i teksten.

Sett inn referanser

1) Sett markgren der du gnsker referansen, og klikk Insert Citation i EndNote-verktgylinjen

~
EN Go to EndNote Style: IAPA norsk bokmal 2018 Y] ‘& Categorize References vl Tools v
[’_L_?',« Edit & Manage Citation(s) l "_E,' Update Citations and Bibliography ] m Manuscript Matcher

Insert PR Help
Citation [TEA. Edit Library Reference(s) ] [FT} Configure Bibliography ‘ TS i (R 5 @ v’

2) Sek etter referansen du vil sette inn, f.eks. pa forfatter, ord i tittel eller arstall. Pass pa at du
spker i Libraries, ikke Shared Groups, nar du henter referanser fra eget bibliotek.


https://www.hvl.no/bibliotek/skrive-og-referere/endnote/
https://sokogskriv.no/referansestiler/
https://kildekompasset.no/

[ ] EndNote 20 Find & Insert My References

Find Citation: [Qv aadland Q]] Search:

Author ~ | Year | Title

Fortelleren og skriveren : en teoretisk og terminologisk av...

Reference Type: Book

Record Number: 26

Author: Aadland, Erling

Year: 2000

Title: Fortelleren og skriveren : en teoretisk og terminologisk avklaring
Place Published: Oslo

Publisher: Spartacus

ISBN: 8243001751

Keywords: Epikk

Narratologi
©
Library: My EndNote Library-Converted.enl 1item in list

3) Med et klikk pa Insert setter du inn en henvisning i teksten, og referansen blir lagt til
i litteraturlisten pa slutten av dokumentet.

= Hvis du bruker en forfatter-arstall-stil, kan du i nedtrekksmenyen av Insert velge om du
vil ha bade forfatter og arstall (Insert), bare arstall (Insert & Exclude Author) eller bare
forfatter (Insert & Exclude Year) med i teksten.
Du kan ogsa bare legge til referansen i litteraturlisten (Insert in Bibliography Only), eller
sette forfatteren utenfor parentes (Insert & Display as: Author (Year)).

Insert & Display as: Author (Year)
Insert & Exclude Author

Insert & Exclude Year

Insert in Bibliography Only

= Alternativ kan du markere referansen(e) du vil sette inn i EndNote, og klikke Insert
Selected Citation(s) in nedtrekksmenyen.

EN Go to EndNote
|”| v
QUF i & vanace citationm | |
E‘b Insert Citation...

E Insert Selected Citation(s)
E Insert Note...

!5. Insert Figure...

Velg referansestil og design av litteraturlisten

= Velg referansestil i stilimenyen.
= Klikk Select Another Style... for a finne installerte stiler som ikke er med i listen.



J) ] Style: IIAPA porskibokmalj2019 1] l@- Categorize References vl Wl ©
| 1 v
Q [TL_’} Edit & Manage Citation(s) I II_E} Update Citations and Bibliography I M Manuscript Matcher

Insert oo Help
Citation IE*'. Edit Library Reference(s) ] IE,'» Configure Bibliography ] l Instant Formatting is Off vl

= Du kan tilpasse font, skriftstgrrelse, innrykk, linjeavstand og avstand mellom
referansene i litteraturlisten under Configure Blibliography - Layout

EndNote 20 Configure Bibliography

[L Format Bibliography
Font: [Calibri size: (12 B

Bibliography title:

Text Format...

Start with bibliography number:

First line indent: |0,000 cm Line spacing: &)
Hanging indent: 1270 cm Space after:

@

Rediger og slett henvisninger

For a redigere referansene i et Word-dokument, bruker du funksjonen Edit & Manage Citation(s).
NB: Ikke skriv direkte inn i formaterte EndNote-felt! Det vil fgre til at endringene tilbakestilles
eller at formateringen gar tapt.
F Style: IAPA norsk bokmal 2018 CI l@_ e S p— VI
Q

L’_"; Edit & Manage Citation(s) l [E‘» Update Citations and Bibliography l ﬂﬂﬂ_ Manuscript Matcher
Insert eyl Help
Citation [E» Configure Bibliography | [ Instant Formatting is Off Vl

E‘g. Edit Library Reference(s) ]

= Det apnes ett nytt vindu med en oversiktsliste over referansene i dokumentet.



[ ] EndNote 20 Edit & Manage Citations

Citation ~ | Count | Library
¥ (Brown & Office, 2009; Taylor, 1991)
+ Brown, 2009 #14 1 My EndNote Library...

4 Taylor, 1991 #21 1 My EndNote Library...
¥ (Bryman, 2006; Hansen, 2010)

(4] Bryman, 2006 #1 My EndNote Library... (%)
4 Hansen, 2010 #19 1 My EndNote Library...
¥ (Harkness et al., 2015)
Harkness, 2015 #16 1 My EndNote Library...
¥ (Lappegérd, 2015)
| anneadrd 2015 #24 - 1 My EndNate |ibrarv (¥ v)

SeNdoiCI (O Reference
[Format: [ Default B

Prefix: | |

Suffix: | |

Fases) A |

® @Y o) D

Totals: 5 Citation Groups, 7 Citations, 7 References

A) Legg til sidetall

= | feltet Pages kan du legge inn sidetall for henvisningen i teksten. Dette gjelder for den
aktiverte henvisningen, og vil ikke pavirke andre instanser.

= Noen stiler stgtter ikke sidetall direkte, og da ma du legge det inn med Suffix istedenfor
Pages.
Pages - Skriv inn bare tallet
Suffix = Skriv inn «, s. sidetall»

= Klikk OK nar du er ferdig med redigering av henvisningen(e).

Eksempel:
F@r redigering: (Bryman, 2006)
Etter redigering: (Bryman, 2006, s. 48)

B) Fjern forfatternavn eller arstall fra henvisning in teksten
= Under Format kan du velge om du vil ha forfatter og arstall med
i referansehenvisningen.

Format:| v Default
Display as: Author (Year)
Prefix: Exclude Author
Exclude Year
Suffix: Exclude Author & Year
Show Only in Bibliography

e

= Klikk OK nar du er ferdig med redigering av referansen.

C) Legg til en referanse pa samme sted som en eksisterende
= Klikk pa tannhjulet og velg Insert Citation.



¥ (Bryman, 2006; Hansen, 2010)

(4] Bryman, 2006 #1 My EndNote Library...
4 Hansen, 2010 #19 1 My EndNote Library... Edit Library Reference
v(Harkness etal., 2018) | (Re=e x =

Insert Citation
3TE Y

Harkness, 2015 #16 1 My EndNote Library...

= Klikk OK nar du er ferdig med redigering av referansen.
D) Slette referanser

= Klikk pa tannhjulet og velg Remove Citation.

¥ (Bryman, 2006; Hansen, 2010)

(4] Bryman, 2006 #1 My EndNote Library...
4 Hansen, 2010 #19 1 My EndNote Library...
¥ (Harkness et al., 2015)

Harkness, 2015 #16 1 My EndNote Library...

Remove Citation

Update From My Library...

= Klikk OK nar du er ferdig med & redigere referansen.
= Henvisningen er na slettet fra dokumentet. Referansen ligger fremdeles i biblioteket.

Oppdatering, formatering og konvertering av referanser i Word

A) Oppdatere referanser

Nar du redigerer referanser i EndNote-biblioteket, ma de oppdateres i Word-dokumentet.
Dette gjgres automatisk innimellom, men kan gjgres manuelt ved 3 klikke pa Update
Citations and Bibliography.

|u' syl [apatn 3 (& cotegor
v
Q [TL_I’;‘ Edit & Manage Citation(s) I "E Update Citations and Bibliography ]

= Configure Bibliography IRSES

Insert
Citation IL?I.*, Edit Library Reference(s) l

B) Avformatere referanser
Skal du flytte tekstavsnitt som inneholder EndNote-referanser eller sla sammen flere
dokumenter, bgr du avformatere referansene fgr du klipper og limer. Da vil Word arbeide

raskere. | sjeldne tilfeller kan kopiering av formaterte EndNote-referanser medfgre feil.
= Klikk pa Tools = Convert to Unformatted Citations

|”| __EN Go to EndNote Style: APA 7th : [@ T v] Tools v -1
@ Edit & Manage Citation(s) ] [F',- Update Citations and Bibliography ] Convert to Unformatted Citations
Insert i
Citation |G Edit Library Reference(s) | [ Configure Bibliography | [ Instant Formatting is On VI

Convert to Plain Text

‘ { Export Traveling Library

Dette fgrer til at litteraturlisten forsvinner, og henvisningene erstattes av EndNote-koder.

(Myhre, Marshburn & Toverud, 1989, s. 48) = {Myhre, 1989, Patologi @48}
Klikk pa Bibliography = Update Citations and Bibliography for a fa referansene tilbake til
formatert form.
c) Konverter referansene til tekst
Det er mulig a opprette et Word-dokument hvor forbindelsen til EndNote er brutt. Her kan

du gjgre siste finpuss i referansene. Dette burde vaere det siste man gjor fgr eventuell lagring
som PDF eller fgr man sender dokumentet fra seg.



NB: Ta vare pa det opprinnelige dokumentet, der EndNote-kodene er intakt. De kan ikke
gjenopprettes i det nye dokumentet.
= Klikk pa Tools = Convert to Plain Text

Organiser EndNote-biblioteket

Organiser biblioteket i grupper

Du kan holde orden i biblioteket ved a legge referansene i grupper.

= Custom groups:
For a lage en ny gruppe, ga til Groups = Create Group. Den nye gruppen finner du igjen under
My Groups i gruppepanelet. Du kan gi et navn til gruppen ved 3 klikke sakte pa den to ganger.
For a legge en referanse i gruppen, drar du referansen fra listen i All References til gruppen i
gruppepanelet.

=  Smart groups:
Smartgrupper samler referansene etter gitte kriterier. For a lage en ny smartgruppe, ga til
Groups = Create Smart group. Det apnes et nytt vindu i det du kan velge et navn for gruppen og
sette kriterier for referansene. Du kan f.eks. sgke etter forfatter, arstall, opprettelsesdato,
database eller ngkkelord. Klikk Create for & opprette smartgruppen.

Smart Group
Smart Group Name: |New Smart Group
[ Author CJ[ Contains CJ[ ] @
(and_ 2)( Year Bl Contains C]l JD
(and [ Title Al Contains C][ ]@
(J Match Case (] Match Words

Slette dubletter

For a unnga stgy fra referanser som er importert flere ganger, kan du sjekke biblioteket ditt for
dubletter. G4 til Library = Find Duplicates. Finnes det dubletter i biblioteket ditt, apnes det et vindu
der du kan sammenligne dublettene. Velg referansen du vil beholde ved a klikke pa Keep This
Record.

Legg til fulltekst

Du kan lagre fulltekst sammen med referansen i EndNote-biblioteket ditt. Legg ved en PDF ved a
markere den aktuelle referansen i EndNote og klikke Attach file under Summary i referansepanelet.

10



£ Bryma...2006 #1 X

Integrating quantitative and qualitative
research: how is it done?

A. Bryman

Qualitative research 2006 Vol. 6 Issue 1 Pages
97-113

Finn fulltekst pa nett

EndNote kan ogsa spke opp fulltekst pa nett. EndNote gjgr da et oppslag basert pa DOl og andre
opplysninger i referansen. Man kan ogsa gjgre oppslag i Oria, med OpenURL Link. Dette krever
registrering av HVLs OpenURL-server:

1) Ga til EndNote 20 - Preferences... > Find Full Text
2) |feltet OpenURL Path fgrer du inn:
http://bibsys-almaprimo.hosted.exlibrisgroup.com/openurl/HIB/HIB_services_page?

o

EndNote™ Preferences

Change Case

Display Fields The Find Full Text feature uses several technologies to maximize the

Display Fonts chances that EndNote will find all available PDFs. Use this screen to control
Duplicates these full text search options.

r— Web of Science Full Text Links

Folder Locations

Formatting DOI (Digital Object Identifier)

Libraries PubMed LinkOut (U.S. National Library of Medicine)

PDF Handling

Read / Unread [ OpenURL I
Reference Types

Sorting OpenURL Path: I\osted.exlibr’\sgroup.com/openurl/HIB/HIB?sarvicesﬁpage?I
Sync

Temporary Citations Authenticate with:

Term Lists URL: ‘ ‘

URLs & Links

Examples: https://login.ezproxy.library.myuniversity.edu/login
http://auth.universityname.edu/authentication

O Automatically invoke Find Full Text on newly-imported references

EndNote Defaults ] [ Revert Panel

11



Marker referansene du gnsker fulltekst til, ctrl-klikk og velg Find Full Text. Fullteksten som blir funnet
pa nett blir na lastet ned og knyttet til referansen i biblioteket. Referanser med fulltekst er merket
med binders-ikon.

Synkroniser biblioteket med EndNote Online

Du kan synkronisere EndNote-biblioteket med en online-konto via Sync funksjonen. Dette gjgr det
lettere 3 fa tilgang til biblioteket fra andre datamaskiner, og du kan jobbe med biblioteket hvor og
nar du vil, sa lenge du har tilgang til internett. Du kan enten opprette konto for EndNote Online
pa siden https://myendnoteweb.com, eller ved & klikke Library = Sync. Om du setter opp andre
datamaskiner til 3 synkronisere mot den samme kontoen, vil de kunne benytte samme bibliotek.
Biblioteket er ogsa tilgjengelig i EndNote Online.

For mer informasjon om EndNote Online, se «Kom i gang med Endnote Online» pa bibliotekets
EndNote-hjelpesider.

Del biblioteket

| EndNote 20 kan du dele et helt bibliotek, og kun ett. Klikk File = Share. Om du ikke har satt opp
synkronisering, tar EndNote deg fgrst giennom denne prosessen. For 3 dele biblioteket, fgrer du inn
epost-adressene for samarbeidspartnerne i det midterste feltet i Sharing-vinduet (Invite More
People). Klikk Invite, sa blir det sendt delingsinvitasjoner pa epost. Mottakerne far en lenke til
EndNote Online, og etter & ha logget seg inn, vil de finne igjen det delte biblioteket i EndNote under
File > Open Shared Library..., forutsatt at EndNote er synkronisert til den samme kontoen.

Om du ikke finner gnsket referansestil i EndNote stilsamlingen

Last ned referansestiler

Det finnes en rekke forskjellige stiler til nedlasting pa EndNotes nettsider. HVL har et mindre utvalg
pa norsk.

Har du lastet ned en referansestil fra nett, installerer du ved a apne filen, og deretter lagre den: File
- Save As... Velg et navn for stilen og klikk Save.

Se lenkene under «Referansestiler» pa bibliotekets EndNote-hjelpesider for referansestiler tilpasset
for HVL.

Redigering av eksisterende referansestiler

Vil du tilpasse en referansestil, f.eks. endre forkortelser, er det enklest a redigere en eksisterende stil.

1) Ga til Edit > Output Styles > Open Style Manager...

| oversiktslisten av stiler kan du krysse av stilene som vises i stiimenyen i EndNote og Word.
2) Marker stilen du gnsker a redigere og klikk Edit
3) Tilpass det du gnsker og avslutt med File > Save As...

Noen vanlige redigeringsmuligheter:

= Velg om tidsskrifttittel skal forkortes:
Journal Names

=  Bytte ut engelske mot norske forkortelser i referansehenvisning:
Citations - Author Lists
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= Bytte ut engelske mot norske forkortelser for sidetall:
Citations - Templates: erstatt «p.» med «s.»
Bibliography = Templates: erstatt «p.» med «s.»

Det meste av stilen er definert under Bibliography - Templates. Her er det definert hvilke
EndNote-felt som skal vises for de forskjellige referansetypene i litteraturlisten. Skal du
redigere noe her, bgr du vaere veldig ngyaktig med tegnsettingen for a fa en feilfri
referansestil! For a legge til et nytt felt, klikk pa Insert Field og velg aktuell felt.

Andre nyttige funksjoner i EndNote

Simple search/Advanced search

Simple search vil spke i alle felter, og ogsa fulltekst, etter sgkeord. Klikk Clear search for 8 komme
tilbake til hele listen. Med Advanced search kan du velge felter for sgkning, og ogsa kombinere sgket
med boolske operatorer.

PDF-redigering

Det er mulig redigere PDF-filer knyttet til referanser i EndNote, f.eks. markere eller understreke
tekstpassasjer, legge til notater, etc.

Tittelregister for tidsskrifter

Noen databaser eksporterer referanser med forkortet tidsskrifttittel, og noen referansestiler krever
full tittel — og omvendt. EndNote kan oversette mellom kort og fullstendig tittel, og kommer med
ferdige tittelregistre for ulike fagomrader:

1) Gatil Library > Open Term Lists = Journal Term List

2) Marker alle termer i listen og klikk pa Delete Term

3) Bytt til fanen Lists og klikk pa Import List...

4) Velg en aktuell liste (bare én) og klikk Choose for a importere listen

= Skulle du ikke automatisk komme til EndNotes termliste nar du klikker pa Import List...,
sa finner du listen under Applications > EndNote - Terms

Importer referanser fra PDF

EndNote har en funksjon for a importere referanser basert pa fulltekstartikler i PDF-format. Dette vil
som regel bare fungere for nyere PDF-er med DOI.

= Import av en enkelt PDF-fil:

1) Gatil File = Import...

2) Under Options og Import Options, velg PDF File or Folder
3) Finn frem mappen eller PDF-filen du vil importere

4) Klikk pa Import
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